Quarter Sized Temperature Recorder

Texas Instruments MSP430-F2013

[image: image1.jpg]



Robert J. Wilson

September 29, 2006

Table of Contents

Chapter 1 - User’s Guide
1

Introduction
1

Background
1

Measuring Temperature
1

Stopping
1

Temperature Report 
1

Install eZ430-F2013 Kit
2

Configure IAR Workbench
2

Dump the Time-Temperature
2

Reporting Time-Temperature 
3

Reset Recorder
4

Room Temperature Graph
4

Chapter 2 - Builder’s Guide
6

Principles of Operation
6

Hardware Modifications
6

Adding the Xtal
6

LiON Battery  - 2032 
7

Software
7

Routine – main
8

Routine – wdt_vector
8

Routine – sd16_vector
8

Routine – gaussian
8

Routine – flash
8

Errata
10

APPENDIX A – Source Code
11

APPENDIX B – Parts List
17


Chapter 1 - User’s Guide

Introduction

This chapter describes how to use an MSP430-F2013 to record office temperatures and report the results. 

Background

Office temperature is often a source of contention. After a complaint is made, it may take hours for someone to show up and by then, the temperature has changed.  But traditional temperature recorders are expensive and rare.

The Texas Instruments (TI) MSP430-F2013 in the eZ430-F2013 development kit can work as a low cost ($25) temperature recorder.

Measuring Temperature

Plugging a modified MSP-EZ430D board, the size of a quarter, into a LiON battery flashes the green LED three times over 40 seconds letting you know the battery is good and the part is working.  Then it begins writing the temperature to FLASH. [image: image2.jpg]



Put the battery and microprocessor in a draft-free container like a pill holder, with the starting time and date. 

FLASH memory holds 281, run-length encoded records with a byte counter for the 8.02 seconds time intervals. Unlikely, it could be filled in 38 minutes to a maximum of 6.5 days.  One office test ran 4 days and still had free FLASH remaining.

Stopping

When FLASH is full, it lights the LED and removing the battery leaves the temperature data in FLASH. To flush the current run-length buffers, change the temperature over a minute by holding it in your closed hand or putting it in a cool space for a minute. 

Temperature Report 

Reporting the temperature requires plugging the MSP-EZ430D target board into the MSP-EZ430U debugging interface and using the IAR Embedded Workbench Integrated Development Environment (IDE) to transfer the time and temperature data to a log file. This log file is loaded into a spreadsheet to plot the results.

Install eZ430-F2013 Kit

Using the CDROM in the kit, install the software and plug in the MSPEZ430U USB debugging device. Windows will prompt to install the USB device driver.  [image: image3.jpg]



Configure IAR Workbench

Plug in the USB debugging device and start the IAR Embedded Workbench. Click on “Create new project” and enter a name for the pop-up and “Save As” field.

After it starts, highlight the project name and use the “Project” pull-down for “Options.” These options setup the IAR system to work.

1. General Options -> Target -> MSP430x2xx Family -> MSP430F2013 – establishes the memory and interface map and generated code.

2. General Options -> Library Options -> Printf -> Small

3. Stack/Heap -> Override default -> Stack size = 80 – nominal stack to support printing the results.

4. C/C++ compiler -> Optimization -> Size = “High (Maximum optimization)” – needed to keep code as small as possible when resetting the MSP-EZ430D target board.

5. Linker -> List -> Generate linker listing -> Segment map -> Module map – protects the recorded time and temperature data.

6. Debugger -> Setup -> “FET Debugger” – to enable USB

7. Debugger -> FET Debugger -> “Retain unchanged memory”

8. Debugger -> Connection -> TI USB FET – sets the USB device interface.

Add a “file” to the project with the source code for “temp_recorder.c”. You can load it from:

http://hiwaay.net/~bzwilson/temp_recorder/
“Rebuild” the code and enter “debug” mode with the USB debugger plugged in. Then under “View” select “Terminal I/O” which is used to display the data. You can close the source file window and disassembly windows and expand the “Terminal I/O” window. Before dumping the data, use “Debug” and select “Logging” to “Set Terminal I/O Log File.” This file will hold the saved data. Use the file options to save the log file where you can find it easily.

Once you exit the debugger, you are ready to dump the time and temperature data. 

Dump the Time-Temperature

1. If the LED is ON, the FLASH is full so remove the MSP-EZ430D board from the battery and install it on the USB debugger. 

2. If the LED is off, you may want to flush the last temperature values from RAM to FLASH by holding the MSP-EZ430D and battery in your hand for a minute. The change in temperature will write the last values to FLASH. Then move the MSP-EZ430D to the USB debugger.

3. Start the IAR Embedded Workbench and “Open the Existing Workspace” project.

4. Select the project and check the “FET Debugger” option to make sure it is on “Retain unchanged memory.” 

5. Enter Debug mode and verify the “Terminal I/O” window is up and “Log file: On”.

6. Hit the three arrow “Go” control and watch the time and temperature display on the terminal window.

Each line has an “interval” counter, a comma and “temperature” in 10ths of a degree Fahrenheit. Let it run until it stops. Then exit the debugger. Until you refresh the FLASH memory, the data will remain in the MSP-EZ430D.

Reporting Time-Temperature 

Using a spreadsheet, load the comma separated values from the Terminal I/O log file. Every pair of lines has an interval counter and the same temperature. The time counter is how many 8.02 second timer intervals for that temperature. For example:

0,776

10,776

10,768

15,768

The first temperature interval lasted to 10*8.02 seconds, 80.2 seconds at 77.6F (voltage scale is 0.1 degree per unit.) The second time interval started at 80.2 seconds to 15*8.02 or 120.3 seconds at 76.8F.

Once you have the data in a spreadsheet, use the starting time from the slip of paper and calculate the remaining time values from the offsets and divide the temperature by 10 to degrees Fahrenheit. This will give you two columns with time and temperature to plot the data. For example:
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This example shows the temperature plotted from room temperature to a thermos of boiling hot water. Cold water was added to bring the temperature down and then the watertight container was removed back to room temperature. Meanwhile, the thermos was drained and ice from the freezer put in the thermos and the container put back in the thermos. Eventually the ice began melting, I pulled the temperature recorder out to add more water and put it back in. Finally, it was left on the table to warm.

Reset Recorder

To reuse the temperature recorder for other measurements, modify the project option, FET Debugger, to “Erase main and Information memory.” Then entering debug mode will reload the code and reset the FLASH for the next temperature measurement.

Room Temperature Graph

The following graph was recorded from 10:00 AM Monday morning to 10:00 AM Friday morning at my desk. The initial drop in temperature came because I had carried the unit in a pocket but it rapidly cooled off once plugged into the battery.

The office temperature problem was the system wasn’t turned on until 8:00 AM instead of an hour before the official work hours. With the data, we contacted facilities and since then, the morning office temperatures have improved:
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Chapter 2 - Builder’s Guide

Principles of Operation

The MSP430-F2013 has a 16-bit ADC with a built-in temperature sensor but it needs a 32.768 kHz watch crystal to keep accurate time. The 16-bit RISC processor has 2 kB of FLASH and 256 B of RAM. The FLASH memory holds both the software and data. 

Hardware Modifications

A proof of concept, this is not designed for mass market production but something anyone could on their own. The schematics and physical MSP-EZ430D drawings came from the Texas Instruments documentation and are used to show the modifications needed.

Adding the Xtal

The first step is to add a watch crystal to the MSP-EZ430D. The following, modified schematics and board layout came from “eZ430-F2013 Development Tool User’s Guide”, Texas Instruments, SLAU176A Mixed Signal Products, 2006, pp. 12-13  :


[image: image6.wmf] 

32.768 kHz watch crystal

 


The VCC needs to between 3.6-2.2 VDC. The 2.2 VDC lower limit is needed to support writing to FLASH. The watch crystal with grounded case needs to go on pins P12, P13 and P14.

The board sketch shows the typical placement of the watch crystal. This location minimizes the height. Although the prototype was not conformal coated, it is recommended if going into a condensing environment.


[image: image7.wmf]

The following photo shows the watch crystal installed on the MSP-EZ430D:

[image: image8.jpg]



LiON Battery  - 2032 

Any 3-3.6 VDC battery can provide power for the MSP430-F2013. In our example, a bead of epoxy spackling is used to hold the B+ and ground wires as a low cost connector. A paper washer separates the epoxy from the connector during the cure.

[image: image9.jpg]



The wire loop is cut, a piece of heat-shrink is put over the ground wire and a solder bead ie put on each end.  Bend the wire leads 90 degrees at the connector and put a drop of clear epoxy to hold. [image: image10.jpg]


 Finally, a 1/2-inch piece of clear heat shrink holds the homemade connector to the battery.

Note that the MSP-EZ430D can work connected to the USB debugger interface. However, this potentially exposes it to laptop heat and the USB debugger is temperature limited to 80C.

Software

The software consists of a main routine that handles initialization and later, printing the results. The watchdog timer is configured as an interval timer driven by the watch crystal and it initiates all measurements. The SD16 interrupts update the RAM cached, with the run-length encoded time and temperature records. 

Routine – main

Entered from a power-on reset, RAM is zeroed and all interfaces are in their default state. Main converts the watchdog timer into a watch crystal driven, interval timer running at the slowest possible rate, 8.02 seconds per interrupt.

The main routine finds the free FLASH memory after the code and checks to see if it is unused. If it is unused, it enables the DCO timer for FLASH memory writes. Finally, it enables the LED for the first time interval and goes into LM3, low power, sleep mode. The interrupt service routine will flash the LED three times as it completes initialization.

If the FLASH memory has been written, it begins printing out the run-length encoded time and temperature values.  This requires the USB debugger to be plugged in and the Terminal I/O window open and logging the results.

Routine – wdt_vector

The watchdog ISR initially loads a five element, Gaussian filter array with the temperature measurements. As each entry is read, the LED changes, flipping from ON-to-OFF and back. This generates three 8.02-second LED flashes indicating the battery and processor are working. Once the first FLASH word is written, the flashing stops.

The watchdog timer works as an interval timer and calls routine start_adc to measure the built-in temperature sensor.  Once the ADC measurement is started, it dismisses the interrupt and goes back to LM3 sleep while the SD16 works.

Routine – sd16_vector

This routine gets the temperature reading and then measures the “zero” value. The “zero” value is subtracted from the temperature measurement and then it is scaled by shifting and the random, low order three bits removed. 

Routine – gaussian

This routine adds each new temperature to a five cell, Gaussian filter. This filter smoothes the data yet preserves the local peaks. It essentially extends the resolution as close to the thermal noise range as possible. The results are then sent to routine flash.

Routine – flash

The flash routine maintains three run-length encoding buffers. These hold the current lowest, middle and highest temperature values with a byte counter for how many samples came in with each value. Any value that matches the current low, middle or high temperatures simply increment the run-length counter.

When the byte counter is ready to wrap, the buffer is written to the next free FLASH memory word as a byte counter and byte temperature value.

Should a new low temperature arrive, the current high temperature buffer is scheduled for FLASH write; the middle becomes the new high; the former low becomes the new middle; and the new low starts a new low record. It shifts the run-length buffers up and writes the former hot record. A new high temperature shifts the run-length buffers down and writes the former cold record. 

Errata

1. The initial calibration of 32F in an ice water batch was done with the USB adapter on an extended USB cable. Subsequent tests on battery power reports the ice water bath at 28F.  This suggests calibration may need code to deal with different voltage levels.

2. One USB FET Debugger was destroyed by high temperature in a steam filled thermos. The last recorded temperature was 158F.

3. The MSP430-F2013 survived a 100C, boiling-water-filled thermos on battery power.

4. The LiON batteries have a narrower operational temperature range than the MSP430-F2013 but the power drain is so low that this does not seem to matter.

5. The Digitally Controlled Oscillator is used to generate the 256 kHz needed to write to flash. It isn’t clear if this can be turned on and off at will.

6. By accident, FLASH was once written using the 32.768 kHz clock. The specifications say it should not be done but we don’t know what the effects would be nor do we know the power required to write to flash.

7. When the FLASH is full, the LED turns solid green but this wastes battery power. A better approach would be to flash the LED but that takes code and reduces the available memory. Batteries are cheap compared to the data.

8. The current print routine library takes FLASH memory and can be replaced by a lower footprint software interface. However, this would require a more complex output reader like a photo-diode detector on a serial line.

APPENDIX A – Source Code

//******************************************************************************

/******************************************************************************/

// 

//  temp_recorder

//

// Interrupt driven, after power-on initialization, the software checks 

//  the first free FLASH word to see if run-length encoded data is present. 

//  If not, the watchdog timer is configured as a watch crystal controlled 

//  interval timer and each 8-second interrupt measures the temperature. 

//  But if FLASH has run-length encoded temperature data, it dumps the 

//  temperature time and values to the USB debugger terminal window and 

//  log file.

//

//  The 16-bit ADC measures the temperature using a built-in thermistor 

//  device. The built-in 'short' interface is used to provide a relative 

//  zero. By happy accident, the low-power, 32 oversampling values are a 

//  simple offset and shift from 1/10th degree Fahrenheit values. However, 

//  the low order three bits suffer from thermal noise and are shifted out.

//

//  To smooth the data, a five-element, Gaussian filter is used on each 

//  data point. This minimizes noise, yet preserves most local peak events.

//

//  The data from the Gaussian filter is stored in a three level, 

//  run-length encoded array. The three levels are the high, middle and 

//  low temperatures saved as a byte value and a byte counter. When a new 

//  high or new low temperature reading occurs, the last array element is 

//  saved as a run-length word and the temperature arrays shift. The 

//  run-length word is written to FLASH and the part goes to sleep again.

//

//  IAR Project -> Options

//     General Options

//        Target -> MSP430F2013

//        Library Configuration -> CLIB

//        Library Options -> printf -> Small

//     C/C++ compiler

//        Optimization -> size -> High (smallest)

//     FET Debugger

//        Erase main and information memory -> to initialize part

//        Retain unchanged memory -> to dump temperature record

//     

//  NOTE: The include files are standard, unmodified, with the IAR system.

//    

//  Bob Wilson, September 19, 2006, bwilson4use@hotmail.com

//

/******************************************************************************/

#include "msp430x20x3.h"

#include "intrinsics.h"

#include "stdio.h"

#include "string.h"

#include "limits.h"

//

//  The maximum temperature in 1/10th degrees should be set by 

//  the battery chemistry. As for the FLASH itself, the limit is just

//  above 100C.

//

#define MAX_TEMP 2200

union rlen {

  unsigned int temp;                       // The run length encoded word

  unsigned char rb[2];                     // The byte values

};

unsigned int * temp_begin;                // Lowest data address

static unsigned int temp_cnt = 0;         // Highest code address

static unsigned int temp_cur = 0;         // Current index

static unsigned char lcnt = 0;              // Count of low values

static unsigned char mcnt = 0;              // Count of medium value

static unsigned char hcnt = 0;              // Count of high values

static unsigned int ltemp = 0;              // Low temperature value

static unsigned int mtemp = 0;              // Medium temperature value

static unsigned int htemp = 0;              // High temperature value

static unsigned int wdt_cnt=0;              // Interrupt counters

static unsigned int sd16_cnt=0;

#define tcnt 6

static unsigned int temp[tcnt];             // Temp measurements

//

//  FLASH operation code runs out of RAM memory in part because

//  it is so slow to write. This following 'flash' module is

//  copied over into RAM, fcode[] and then called with the data to be written

//  and location.

//

void flash(unsigned int stemp)

{

  union rlen rle;                   // Local data

  //

  //  Range testing

  //

  if ( stemp > 32768 )              // Did we measure a negative temp?

  {

    stemp = 0;                      // Lowest temp is 0

  }

  //

  //  Shutoff if TOO HOT!

  //

  if ( stemp > MAX_TEMP )           // Have we reached limit?

  {

    _BIC_SR(GIE);                   // Stop interrupts

    _BIS_SR(LPM4_bits);             // Save yourself, try to shutoff

  }

  //

  //    Run-length encoding code

  //

  rle.temp = 0;                 // Nothing for now

  if ( (lcnt == 0) & (hcnt == 0) & (mcnt == 0) ) // First entry?

  {

    htemp = stemp;                    // Use first temp for both

    mtemp = stemp;                    // Medium temperature

    ltemp = stemp;                    //   so we have a start

    lcnt = 1;                         // Count this one

    return;                           // Done for now

  }

  //

  //  See if we have an ltemp match

  //

  if ( stemp == ltemp )

  {

    if (lcnt < UCHAR_MAX)           // Still within count range?

    {

      lcnt++;                       // Count this low temp

      return;

    }

    rle.temp = ltemp >> 3;      // Shift into a byte

    rle.rb[1] = lcnt;           // take the count

    lcnt = 1;                   // Keep temp, restart counter

  }

  //

  //  See if we have an mtemp match

  //

  if ( stemp == mtemp )

  {

    if (mcnt < UCHAR_MAX)           // Still within count range?

    {

      mcnt++;                       // Count this low temp

      return;

    }

    rle.temp = mtemp >> 3;      // Shift into a byte

    rle.rb[1] = mcnt;           // take the count

    mcnt = 1;                   // Keep temp, restart counter

  }  

  //

  //  See if we have an htemp match

  //

  if ( stemp == htemp )

  {

    if ( hcnt < UCHAR_MAX )         // Still within count range?

    {

      hcnt++;                       // Count this high temp

      return;

    }

    rle.temp = htemp >> 3;      // Shift into a byte

    rle.rb[1] = hcnt;           //  take the count

    hcnt = 1;                   // Keep temp, restart counter

  }

  //

  //    See if a new low has arrived

  //

  if (stemp < ltemp)              // New cold temperature?

  {                               // YES - dump the last high

    rle.temp = htemp >> 3;        // Bring temp to a byte value

    rle.rb[1] = hcnt;             // New RTL is ready

    htemp = mtemp;                // Shift up ltemp

    mtemp = ltemp;                //  save the new mtemp

    hcnt = mcnt;                  // and counter

    mcnt = lcnt;                  //  save in new mtemp

    ltemp = stemp;                // Save the current

    lcnt = 1;                     // Start counting

  }

  //

  //  See if a new high has arrived

  //

  if (stemp > htemp)              // New hot temp?

  {                               // YES - dump the last low

    rle.temp = ltemp >> 3;        // Bring temp to a byte value

    rle.rb[1] = lcnt;             // New RTL is ready

    ltemp = mtemp;                // Shift down htemp

    mtemp = htemp;                //   into the medium

    lcnt = mcnt;                  //   and counter

    mcnt = hcnt;                  //   including medium counter

    htemp = stemp;                // Save the current temp

    hcnt = 1;                     // Start counting

  }

  //

  //  Halt the watchdog, write flash, restart watchdog

  //

  WDTCTL = WDTPW + WDTHOLD;       // Turn off the watchdog timer, for now, no recursion

  temp_begin[temp_cur] = rle.temp; // Save the run length encode value

  temp_cur += 1;                // Point to next

  if ( temp_cur <= temp_cnt )

  {

    WDTCTL = WDTPW +            // Makes the watchdog work as a timer

      WDTSSEL +                 // use 32,768 kHz clock, / 32768, ~9.5 sec

        WDTTMSEL ;              // Puts in interval time mode  

  }

  else

  {

    P1OUT = 0x01;               // Enable the LED, done.

  }

}

void gausian(void)

{

  unsigned long sum;      // Start the conversion

  sum = (6 * temp[3]) + (4 * (temp[2]+temp[4])) + (temp[1]+temp[5]);

  sum /= 16;              // Normalize

  sum += 4;               // Add half of shift

  sum = sum >> 3;         // Shift out lower bits

  sum = sum << 3;         // Shift back to normal, *8

  flash( sum );           // Write the flash value

}

void start_adc(int sd16inctl0)

{

  //

  //  Configure the SD16_A to read the thermistor voltage

  //

  SD16AE = 0;                 // No external interfaces

  SD16INCTL0 = sd16inctl0;    // Input control register

  SD16CTL =                  // Control register

    0 +                      //   clock divider

      SD16LP +                 //   low power mode 

        0 +                      //   clock divider

          SD16SSEL1 +              //   use ACLK 

            0 +                      //   V(MID) buffer off (not in 2013?)

              SD16REFON +              //   reference on

                SD16OVIE ;               //   enable overflow interrupt

  SD16CCTL0 =                 // Channel 0 control register

    SD16UNI +                 //   unipolar mod

      //SD16XOSR +                //   extended mode, 1024 sampling

      SD16SNGL +                //   single conversion

        SD16OSR1 + SD16OSR0 +    //   32 oversampling

          0 +                       //   don't toggle on SD16MEM0 reads

            SD16LSBACC +              //   read the low order 16-bits

              0 +                       //   offset binary, not 2s complement

                SD16IE +                  //   interrupt enable

                  SD16SC ;                  //   start conversion

}

//

//  This is entered via a Power On Reset and the 'glue' logic includes

//  an invisible routine to clear the RAM. By default, the watchdog

//  timer re-enters this way, thus wiping out all flags and counters.

//

void main(void)

{

  WDTCTL = WDTPW + WDTHOLD;       // Turn off the watchdog timer, for now, no recursion

  //

  //  Setup the clocks for all functions

  //

  BCSCTL3 = 0;                     // Use Xtal, lowest 1 pf stablity

  BCSCTL2 = SELM1+SELM0 + DIVM1+DIVM0 + DIVS1; // Xtal drives MCLK, /8, DCO -> SCLK

  //

  //  We use DCO at 1 mHz, divided by 4, for FLASH writes.

  //

  BCSCTL1 = CALBC1_1MHZ;      // Set the calibrated clock value

  BCSCTL1 |= DIVA1+DIVA0;     // 1 mHz, Divide Xtal / 8 for ACLK

  DCOCTL = CALDCO_1MHZ;       // Set DCO step and modulation

  //

  //  Find the available FLASH memory for data storage.

  //

#pragma segment="DATA16_C"

#pragma segment="INTVEC"

  temp_cnt = (unsigned int) __segment_end("DATA16_C"); // Grab the last byte

  temp_cnt += 1;              // Move up one

  temp_cnt &= 0xfffe;         // Round to word boundry

  temp_begin = (unsigned int *) temp_cnt; // Point to first FLASH word

  temp_cnt = (unsigned int) __segment_begin("INTVEC") - temp_cnt; // Remember the end

  temp_cnt /= 2;              // Make it a word count

  if ( temp_begin[0] == 0xffff ) // Is first flash still unused?

  {

    FCTL1 = FWKEY + WRT;        // Make flash writable

    FCTL2 = FWKEY + FSSEL_3 + FN2;  // Use SCLK, / 4

    FCTL3 = FWKEY ;           // Turn off the locks, 

    //

    //  Setup the watchdog timer as an interval timer

    //

    WDTCTL = WDTPW +            // Makes the watchdog work as a timer

      WDTSSEL +                 // use 32,768 kHz clock, / 32768, ~9.5 sec

        WDTTMSEL ;              // Puts in interval time mode

    IE1 |= WDTIE;               // Enable timer interrupts when GIE enabled

    //

    //  Initialize the output LED port and go to sleep

    //

    _BIS_SR(GIE);               // Enable the interrupts

    //

    //  Enter the lowest possible, wait state pending interrupt(s).

    //

    P1DIR |= 0xFF;              // Avoid floating pins drain, set unused to output

    P1OUT = 0x01;               // Enable LED

    _BIS_SR(LPM3_bits);         // Turn off CPU in idle loop

    //   MCLK, SMCLK, DCO osc disabled

    //   DC gen. disabled

    //   ACLK remains active

    //   LED still flashes

    //

  }

  else                        // No - report the values

  {

    int i = 0;                // Counter for flash memory

    unsigned long sec = 0;    // Counter for elapsed time

    union rlen rle;           // Local decoder for run length

    unsigned int ltemp=0;     // Local time

    while ( temp_begin[i] != 0xffff ) // Pass through data

    {

      rle.temp = temp_begin[i]; // Pickup compressed into two bytes

      if ( rle.rb[1] > 0 )     // Is this a counted temperature?

      {

        printf("%ld,", sec);     // Lets see the last second start

        sec += rle.rb[1];       // Add the seconds byte to new end time

        rle.rb[1] = 0;          // Clear out the temp bits

        ltemp = rle.temp << 3; // Restore temperature

        printf("%d\n%ld,%d\n", 

               ltemp, sec, ltemp); // Lets see the temperature

      }

      i += 1;                    // Point to next

    }

  }

}

// 0xFFF4 Watchdog Timer - start temperature measurement

#pragma vector=WDT_VECTOR

__interrupt void wdt_vector(void)

{

  wdt_cnt +=1;                // Count ISR

  if ( wdt_cnt >= tcnt )      // Have we reached limit of temp array?

  {

    gausian();                 // Convert the gausian array

  }

  start_adc(SD16INCH2 + SD16INCH1);   // Begin temperature recording

  if ( temp_begin[0] == 0xffff ) // Are we still getting started?

  {

    P1OUT ^= 0x01;            // Flash LED to other state

  }

  else

  {

    P1OUT = 0;                // Everything off

  }

}

// 0xFFEA Sigma Delta ADC

#pragma vector=SD16_VECTOR

__interrupt void sd16_vector(void)

{

  sd16_cnt +=1;                  // Count ISR

  int i;                         // Counter for data shifts

  SD16IV = 0;                    // Suppress recursive interrupt

  i = SD16INCTL0 & (SD16INCH2+SD16INCH1+SD16INCH0) ; // Get the source bits

  if ( i == (SD16INCH2+SD16INCH1+SD16INCH0) ) // Was this a zero request?

  {

    temp[0] = temp[0] - SD16MEM0;    // Adjust for zero

    temp[0] /= 4;                    // Scale to 0.1F

    temp[0] -= 4516;                 // Offset to base for 32 F.

    temp[0] += 4;                    // Add half of shift

    temp[0] = temp[0] >> 3;          // Shift out lower bits

    temp[0] = temp[0] << 3;          // Shift back to normal, *8

    for (i=tcnt-1; i > 0; i--)     // Pass through existing array

    {

      temp[i] = temp[i-1];         // Shift all values up

    }

    temp[0] = 0;                  // Clear the low

  }

  else                            // No, assume a data request

  {

    temp[0] = SD16MEM0;           // Get the value

    start_adc(SD16INCH2 + SD16INCH1 + SD16INCH0); // Get the zero to adjust

  }

}

// End of code segment?

APPENDIX B – Parts List

There are multiple sources for these parts besides my ‘stuff’ box:

Vendor
Description
Part Number
Estimated $

Texas Instruments
Ez430-F2013 development kit with MSP430-F2013 microcontroller
EZ430-F2013
$20.00

Allied Electronics
32.768 kHz watch crystal or equivalent
614-0186
$0.30

Allied Electronics
20 mm. coin cell, 3-3.5V or equivalent
774-0113
$0.60

Allied Electronics
Half-inch, clear, shrink wrap or equivalent. Only 0.5 x 0.5 inch per cell, 100+ cells
708-9214
$13.00

Allied Electronics
Epoxy putty. For ~50-100 cells 
796-9831
$8.00

Allied Electronics
0.010 inch wire, 24 AWG or equivalent. For 1,000 cells
293-1306
$10.00

The homebrew, epoxy connector can be replaced by a Mill-MAX, single-row, .050” grid interconnect, Allied Electronics part 900-2000, $5.18, enough for 10 cells.

The heat-shrink, coin cell holder could be replaced by a coin cell specific holder. Typical prices are ~$1.00 each from Allied Electronics but need to be matched to the specific coin cell and end packaging.

A water tight, metal pill fob with internal ¾” diameter, 19.5 mm, is available from local pharmacies for about $5.00 for (See http://www.jfainc.com/pillfob.html). Even without a little sandpaper trimming, it will fit but a smaller than 20 mm diameter button cell will be needed.
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